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A.  Creating and Printing Reports
Case spreadsheets are the raw material that make up your CaseMap reports — many of which are 
required by the court. With a few mouse clicks, you can create professional reports instantly in 
Adobe® Acrobat, Microsoft ® Word, or just printing them on paper. Using the Facts spreadsheet you 
can easily turn your fact chronology into Motions for Summary Judgment and produce the list of 
facts that you’re willing to stipulate for pre-trial motions. With CaseMap reports, What-You-See-
is-What-You-Get, so what is displayed in your spreadsheet view is the same as what you see in 
your report. Make sure you have fi ltered your spreadsheet content and sorted records to create the 
view you want before printing your reports.

CaseMap also off ers four pre-built reports that you can easily produce using a wizard to guide you 
through the steps. Pre-built reports include the following options: Privilege Log, Summary Judg-
ment, By Issue Report, By Object Report.

A.  Creating a Case
Before working in CaseMap, you fi rst need to create a case fi le to  store 

information regarding the matter.  

To create a new case:
1. On the File menu, click New Case.
2. Follow steps in the New Case wizard to set up case information.

 •  Th e time zone should refl ect the primary location where your case  
     and most facts and events occur. 
 •  Add case users later once the case is created and any custom 

     fi elds or views are added.
 •  Save the case to a network folder so others can access it.
3. Click Finish to create the new case fi le and launch the new Case   

 Jumpstart Wizard.

B.  Creating a Cast of Characters
CaseMap’s objects spreadsheets are used to organize your list of “nouns” 
and Cast of Characters regarding the case, including persons, places, 
events, documents, evidence, proceedings, and pleadings.

Short Names:

When names are entered, CaseMap automatically creates short names 
- unique names for each object entered in a case. Short names are 
what make linking case data possible. When a short name is identifi ed, 
CaseMap automatically links the object to case information: facts, issues, 
questions, and research. Th is feature is what allows you to search and 
view data in various ways so you can quickly locate essential information 
and create reports that shape and support your case strategy. For more 
information and tips on short names, see the CaseMap Answer Center.

• Cast of Characters
• Client Interviews
• Case Issues
• Documents
• Pleadings
• Depositions
• Exhibits
• Research
• And more
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• Analyze data: complete spreadsheet fi elds
• Sort spreadsheet data
• Search case data
• Review and annotate in DocManager
• Filter spreadsheet data to create reports

Case Analysis

To enter a basic Cast of Characters:
1. In the Case Jumpstart Wizard, click on the appropriate link to   
 type in your character name. Th e wizard provides pages for
 Litigants, Judges, Opposing Counsel, Witnesses, Other People,   
 and Other Organizations.
2. When you’re done, click Finish. Th e All Objects spreadsheet   
 displays so you can review your Cast of Characters. Notice how   
 each object has a short name created for it.
3. In the Case Shortcuts pane, click the All Shortcuts bar to view   

 the Cast of Characters organized by sub-object spreadsheets.

C.  Entering Issues
When you fi rst create your case, start outlining your issues in the Issues 
spreadsheet so you can quickly develop a hierarchy of claims, counterclaims, 
and any other known arguments. 
Th e Issues spreadsheet can hold as many levels or sub-issues as you want 
and is automatically numbered (1, 1.1, 1.1.1) to indicate main issues and 
sub-level items for a case.

To enter issues:
1. On the Home tab, click New Record, and then click Issues.
2. In the Full Name fi eld, type in the full name for the issue. 
3. Press Tab to navigate to the next cell.
 CaseMap automatically creates a short name for the issue to   
 link issues to fact records and other case data.
4. To create a sub-level issue, click the arrow pointing to the right.   
 CaseMap automatically saves each record as you move to a   
 new record or fi eld.

Creating and Setting Up a Case

To print to PDF:

1 On the Reports menu, click the PDF 
       button.  

2 On the submenu, click Print to PDF or  
 Print to PDF (Email). Th e Print to PDF  
 Email option includes the PDF report in  
 an Outlook email that you can send to  
 case staff  or clients.

To print to Word, Excel, TimeMap, NoteMap, 
HTML, or Corel WordPerfect:

1 In CaseMap, select/highlight the 

 spreadsheet type and the record to print..

2 Right-click in a fi eld of the selected record,  
 click Send To, and then select an appropri 
 ate print option.

 Some options allow you to select either a  
 Grid or Record View. Try printing both to  
 see which view you prefer.

To print a CaseMap pre-built report:

1 On the Reports menu, click the pre-built  
 report you want to print: Privilege Log,  
 Summary Judgment, By Issue Report, or  
 By Object Report.

2 When the report wizard launches, follow  
 the steps in each box.

3 When you complete the wizard and the  
 report displays, you can save it as a Word  
 fi le to the network folder where you store  
 reports.

To print and view a ReportBook:

1 On the Reports menu, click
 ReportBooks, and then select the 
       ReportBook you want to print.

2 On the submenu, click Preview.
3 Aft er previewing the document, click Print  
 to PDF or Print to PDF (Email).

4 In the Save As PDF dialog box, navigate  
 to the network folder where you save  
 reports, and then click Save.

5 In the message box, click Yes or No to 
 embed linked fi les. If you click Yes, select  
 which fi les you want to include in the  
 ReportBook, and then click OK.

6 In the message box, click Yes to view the  
 ReportBook.

7 In the Bookmarks pane, click on a
 bookmark link to view that section of the
 report.

8 In the ReportBook PDF fi le, click the
 paperclip icon in the lower left  corner to  
 display embedded linked fi les.

9 Double-click on a linked fi le to view it in 

       its native application.

B.  Printing ReportBooks
ReportBooks are living documents that can be used throughout the life of the trial that are es-
sential for ensuring that clients and case staff  stay abreast of case developments and can readily 
collaborate in the case analysis process.

A ReportBook is a compilation of CaseMap reports packaged with optional elements such as a 
cover page, table of contents, confi dentiality statement, introduction, and report-specifi c title 
pages. Th e layout is similar to the standard report generated when you print one of CaseMap’s 
spreadsheet views. CaseMap off ers eight pre-built ReportBooks for you to choose from, including a 
complete Case Summary (as shown above) and an overview of What’s New in the Last 14 days.

ReportBooks are printed to a PDF fi le. You can choose whether to embed linked fi les in your Re-
portBook so that others can click on a document or fi le and view it in its native application.

Litigators use ReportBooks in a variety of ways:
•   Produce a ReportBook shortly aft er client intake to show clients that you have captured

  their concerns.
•   Compile a ReportBook to present your case to investigators, arbitrators, clients, and other  
  key decision makers.

•   Save your ReportBooks in PDF and link them to correspondence.
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Getting Data into CaseMap
CaseMap off ers several ways to get case data into your case fi le.

    Th ere are three main ways to get data into CaseMap:

    •  Manually entering data into spreadsheets

    •  Bulk importing data using the Import Linked Files Wizard    

    •   Sending facts and data from other programs (like Microsoft ® Word, Mi-

crosoft ® Outlook, Concordance®, TextMap®, and Adobe® Acrobat).

A. Manually Entering Data
As you gather new case information, you can manually create a new record 
on any spreadsheet to update the case. To create new record, click the New 
Record button on the Home ribbon Records are saved automatically as you 
navigate from record to record. To re-sort the spreadsheet, click Home > 
More button > Refresh Spreadsheet.

Need CaseMap Training? Visit us at LexisNexis University: http://www.lexisnexis.com/university/litigation-solutions. To access a free trial or purchase a 

DocManager subscription, contact your sales representative at 866-316-8525 or email sales@lexisnexis.com.

C. Using the Send to CaseMap Tool
You can easily send fact text or documents directly to your case from other 
programs. While building the chronology with facts linked to documents, 
you can enter fact details, link to case elements by using short names and 
issues, and mark the status of the new fact.

Steps for sending facts or documents are nearly identical for each product. 
For complete step-by-step instructions for all supported products, see the 

CaseMap Answer Center. 

To send a document from Adobe Acrobat or Reader:
1 With your PDF fi le open, right-click in the document and click Send  
 PDF to CaseMap. 

2 In the Send to CaseMap dialog box Object Type list, select Document.
3   Type in the document name or edit the Full Name fi eld, then click Save.
4 In the Send to CaseMap dialog box, click Yes to view the 
 new document record in CaseMap.

 Note: To send a fact, click the Send Fact to CaseMap in the PDF fi le.

To send facts and fi les from Word:
Send to CaseMap features display on a CaseMap ribbon within Word. Th e 
add-in is optional during CaseMap v10 installation.

1 Open the CaseMap case that you want to import data into
 from Word.

2 In the Word document, highlight the information you want to   
 send, then click CaseMap > Send to CaseMap - Add Fact button.

3 When the Send to CaseMap utility launches, select the spreadsheet  
 you want, type in the document name, and then click OK.
4  In the Send to CaseMap – New Fact box, select Fact Text in theAppend 

Text Selection to fi eld so that the excerpt displays in the   
Facts spreadsheet.

 Note: Th e text selected displays in the Text Selection fi eld and is   
 enclosed in brackets. Do not delete the brackets. Removing them   
 prevents CaseMap’s recognition of short names and designate   
 actual document text for the import.

5  In the Favorites Fields area, enter in additional fact record details like 
the date & time.

6  Click the Issue Linker bar to link the record to an issue.
7  Click OK to initiate the import process.
8  In the message prompt, click Yes to view the new fact record in the 

Facts spreadsheet.
9  Click in the Fact Text fi eld to view the highlighted text you sent from 

the Word document.
10  Click on the paperclip icon for the fact record to view the linked fi le 

path and open the fi le in Word.
11  Scroll to the right and notice that the Source(s) fi eld displays the linked 

element to the Word document and that the Linked Issue fi eld displays 
any issues added for this record.

12  Click on the Documents spreadsheet to view the record created for the 
linked Word fi le. If you only want to send the Word

 document, click the Send to CaseMap – Add Object button.

A. Analyzing Spreadsheet Records
Aft er getting data into Casemap, you’ll want 
to analyze spreadsheet records and complete 
information in each fi eld. For example, on the 
Facts spreadsheet, you’ll want to mark which 
facts are relevant (Material fi eld) and whether 
the facts are disputed (Status fi eld).

B. Sorting Fields
Sorting determines the order case elements display in a spreadsheet view, allowing you to review 
information in various ways to determine what items need to be addressed fi rst or categorized based on 
the status of items. To sort a fi eld, right-click on the fi eld header (title), and then click Sort Ascending or 
Sort Descending. To sort multiple fi elds, click the Advanced Sort button and enter the fi elds you want to 
sort.
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C. Filtering Spreadsheet Records
Filtering allows you to cull data for reports or save fi lters to 
rerun later when additional information is added to the case. 
Records that meet the criterion of your fi lter remain in view 
on the current spreadsheet; while other records are tempo-
rarily hidden from view. You can fi lter by key words, fi eld 
status setting, or create multi-level fi lters (key word + fi eld 
status). You can also run pre-built fi lters from the Records 
menu, by clicking Filters and selecting an option from the 
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E. Viewing Documents and Images in DocManager
Content analysis can be done in CaseMap’s DocManager near native image viewer. DocManager allows you to review and annotate documents and images 
without having to open the source fi le in its native application. You can add notes to annotations, edit annotations and notes, and also search annotation 
notes. Annotation colors can be changed by each user, but only one color is used for printing. When a search is run, search hits are highlighted in DocMan-
ager allowing you to review content and navigate between search hits. Current search hits are highlighted in blue. All other search hits are highlighted 
in yellow. You can then view and print the Linked File Text Hits and Review Linked File Hits reports. You can batch print linked document fi les with or 
without Bates stamps and choose whether to include annotations and notes in the printed output.

B. Importing Documents and Files into a Case
Th e Import Linked Files Wizard guides you through importing one or 
more documents/fi les into your case. Th e wizard will create a new record 
for each document you select to import. Aft er the import, CaseMap in-
dexes all new fi le content. You can begin searching the updated case data as 

soon as the index process completes.

To bulk import documents:
1  On the File menu, click Import, and then click Import Linked Files 

from a Folder.
2 In the Import Linked Files Wizard, click Next.
3  In the Select Files to Import dialog box, click one of the import
 options: Add Files or Add Folder.
4  In the Select Files to Import dialog box, navigate to the folder where 

the fi les are saved, and select the fi le or folder to import, and then click 
Open. Th e fi les now display in the Selected fi les box. 

5  Aft er reviewing the fi les, click Next.
6   In the Spreadsheet drop-down list, click the spreadsheet for which you 

want to import the fi les, and then click Next.
7  In the Ready to Import dialog box, review the fi les and spreadsheet you 

selected for the import.
8  Click Next to initiate the import process.
9 In the Completing the Import Linked Files Wizard dialog 
     box, review the number of fi les imported, then click Finish. 
     Th e new records display in the selected spreadsheet.
10 In the Completing the Import Linked Files Wizard dialog 
     box, review the number of fi les imported, then click Finish. 
     Th e new records display in the selected spreadsheet.
11 In the Case Shortcuts pane, click on the spreadsheet.
 A paperclip icon displays next to each record to indicate   
 that a linked fi le is attached.
12 Click on the paperclip icon to view the fi le in its native
 application or in the DocManager viewer.

Th e Web-based CaseMap Answer Center brings together helpful topics and useful information.  It’s all just a click away.

On the CaseMap Help menu, click Contents to launch the CaseMap Answer Center.

Th e Search Results navigation pane has four parts:

Search fi eld — Allows you to type in full-text search terms.

Narrow Results panel — Allows you to view search hits found in spreadsheet 
fi elds, linked fi le text, or annotation note text. Th e number of search hits found 
displays to the right of the results.

To view a document or image fi le:
In a spreadsheet, click on the paperclip icon for the linked fi le you want to view. To view

multiple documents at one time, click the Pin icon in the upper right corner to this position.

To navigate search hits:
Click the Previous Hit and Next Hit buttons in the lower left  corner of DocManager. You can also 
click on or type a number in the Page list to jump to that page.

To annotate documents or images:
1.  Open a linked fi le in DocManager and click the Annotation mode button.
2.  Click Annotate Text. You can also click the Tools menu and then click the fi rst menu item  
 on the shortcut menu, and click Annotate Text.
3.  Drag your mouse pointer over the text you want to annotate to open the New Annotation  
 dialog box. Th e text you selected now displays in the Document Text box.
4.  In the Note tab, type in information you want and then click OK.
 

 Tip: If the selected text is worthy of a new fact record, click the Create New fact button to  
 add it to the Facts spreadsheet.

Results panel — Displays all spreadsheets that contain records or linked fi les 
with search hits. Th e number of search hits found displays to the right of the 
spreadsheet name.

Resources panel — Provides access to three search results reports.

submenu. Th e fi lter menu options change depending on the spreadsheet you are viewing.

D. Searching Case Data
CaseMap allows you to quickly search case data because of the comprehensive index created during 
the import process. You can search and locate all instances or “hits” of your search terms in spreadsheet 
records, linked fi les, and annotation notes.

Search terms can be more than one word. Th ey can also be numbers, text phrases, or a combined use 
of terms and search operators. To run a previous search or search by selected spreadsheets, click the 
Records menu and then click Full Text Search.

Aft er a search is run, search results display in two areas in CaseMap: the Search Results pane and the 
spreadsheets pane. Print the Search ReportBook to create a report of each spreadsheet record and all 
linked fi les located based on your search query.

Case Analysis
Analyzing case data tells you what you already know and points the way to important information that you may need to know more about. Searching, sorting, 
tagging, and fi ltering case information from various angles may off er insights not otherwise noticed.


